
We've been talking about the Scavenger Hunt for 
several months now...  and many of you have signed 
up. Now that 2018 is upon us, I need to have a better 
idea of how many people and teams we will have for 
this fun event.  Teams should be formed no later than 
February 2018.  Especially if you are new to the club, 
I encourage you to sign up! Seasoned members are 
welcome too!  This really is a great way to get to know 
fellow members, spark your creative juices, stretch 
your boundaries, and grow as a photographer! If you 
want to participate but don't have a team assembled, 
let me know and I will find a team for you.

To recap, here is how it works... The teams should 
be formed by our February 2018 meeting, and the 
scavenger list of about 10 things to photograph will be 
published shortly afterward. The assignment list could 
be actual things like a barn or a ladder, or they could 
be more conceptual like shadows or reflections
(similar to our monthly competition Assigned Subject). 
The idea is to find and photograph these items, but 
not actually collect the item itself, as in a traditional 
scavenger hunt.  I've included some of the photos from 
the winning team from our 2016 Scavenger Hunt to 
whet your interest.
  
Teams will have two to three months to complete
the scavenger list (March through sometime in May). 
This allows the maximum flexibility for the teams to 
find days when then can meet and shoot, or discuss 
how they are going to photograph the list, as well as
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DANCER -
Tiny Dancer in Big City

by Becky Humes

HAT - Shy Innocence
by Becky Humes

CURRENCY -
African Trade Beads

by Becky Humes

Photos below are from
the 2016 Scavenger Hunt

winning team.

Time To GeT our 2018 Teams Formed
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SCAVENGER HUNT - Continued from previous page

choose which images they are going to submit.
Meetings can be over coffee, or by email. Teams can 
shoot individually or as a group, on a single day or
multiple days. Whatever works for their schedules. 
HOWEVER, the submitted scavenger hunt photos
MUST BE TAKEN during the challenge time period,
and adequately represent all the members of the group.
In other words, you can't pull an image from your
archives that you took 3 years ago on your trip to Italy...
and all 10 images can't come from the same person. 
The teams would submit one image for each scavenger 
list item, choosing the ones they collectively deem the 
best.  So in a 10-item-list scenario, each team would 
submit 10 images.

Photos below are from the 
2016 Scavenger Hunt

winning team.

MILITARY / VETERAN -
Ultimate Sacrifice
by Kathy Kendall

FOUNTAIN -
Make Two Wishes
by Becky Humes

MUSICAL
INSTRUMENT -
Orb On Piano

by Becky Humes

The submitted scavenger hunt photos 
MUST BE TAKEN during the challenge time period,
and adequately represent all the members of the group.

At our June 2018 meeting we will show the results of the 
team submissions as our program. The members at the 
meeting will vote for the team they thought most creatively 
completed the scavenger hunt. I hope I can get prize
donations again for the
winning team members.

New LapTop FuNd

The club needs a new laptop computer for presentations and competition images. The estimated 
cost of the laptop and software is $1,500. We hope to receive donations for the fund in order to 
purchase the needed equipment.

Remember, your donations are tax deductible. We will have envelopes for your donations at the 
next few meetings. Thank you for your donations.
(See page 13 for Laptop Fund Update.)

by Becky Humes, GRCC President
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We will start 2018 with a program presented by GRCC's own 
Mike Mitchell that will delve into a more technical side of 
photography.

Tethered shooting is connecting a digital device (such as a 
computer) to the camera when you shoot, so the pictures you 
take are immediately downloaded to the computer rather than 
(or in addition to) a memory card. Usually, the camera and 
computer are connected by cable, hence the name tethering. 
However, with the advent of Bluetooth and WiFi enabled
cameras, cables are not always required!

Tethering your camera to a computer, tablet or smart phone 
is a great tool to help improve your photographic technique.  
Whether you shoot in a studio or out on location, tethering is a 
great way to get the instant feedback needed to improve your 
images.

Mike's presentation will be a basic overview of what you need 
in order to connect a camera with either a cable or wirelessly to 
your computer, tablet or smart phone.  He will discuss the
hardware and software to use depending on your needs.

Mike has been shooting since the tender age of nine or ten. Currently he 
works as a senior photographer for Meijer Inc. When not making pictures 
for them, he makes pictures for himself. He has been an active GRCC 
member for many years. Mike has given numerous presentations and led 
workshops for a number of West Michigan camera clubs and photography 
groups. He has also presented several times at the SWMCCC Summer 
Weekend of Photography. Mike has had his images exhibited in two
one-man shows, as well as a number of multi-artist venues.
You can follow Mike on his Photoblog at: http://votrepear.aminus3.com/

meeTiNG
preseNTaTioN:17

Jan.

Wed.

Grace episcopaL church, 1815 haLL sT. se, GraNd rapids, mi

GuesTs are aLways weLcome aT our meeTiNGs. There is No GuesT Fee To aTTeNd This meeTiNG.

by Jan Lewis,
VP of Programs

Presented by
Mike Mitchell

As always, GRCC members attend free.

shooTiNG TeThered

Jan Lewis VP- Programs
programs@grcameraclub.org

shooTiNG TeThered

http://votrepear.aminus3.com/
mailto:programs@grcameraclub.org
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I have been lining up program speakers for the coming year.  Listed below are those
currently scheduled.  As always, schedules can change, so be sure to check your
Lights & Shadows and the website to confirm the scheduled speakers each month.

our 2018 proGram scheduLe by Jan Lewis, VP of Programs 

Jan. 17 Mike Mitchell Shooting Tethered

Feb. 21 YEAR END Year-End Banquet and Awards

Mar. 21 MINI-PROGRAMS  Mini-Programs

Apr. 11 Joe Lapeyra Travel Photography

May 16 Paul Jendrasiak Rock Star Images - Event Photography

Jun. 20 Scavenger Hunt Scavenger Hunt Results

MONTH SPEAKER PROGRAM TITLE

2018

We are in desperate need of a new snack person(s). Caroline 
has done it for many years. We greatly appreciate all she has 
done. December was her last month volunteering, so we will 
no longer have snacks and coffee until we have a new snack 
coordinator(s). Our club needs volunteers to keep
everything running smoothly... even a
commitment for a year will help.

sNack VoLuNTeers by Becky Humes, GRCC President
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compeTiTioN corNer by Jeanne Quillan, VP of Competition 

It is time again to get your entries together for our annual Year-end competition. It is the highlight of the com-
petition year and the only competition where members compete for awards on their best images. Only images 
that were entered in 2017 are eligible. The deadline for digital images is January 10, 2018. The deadline for 
prints will be January 17, 2018 (our January meeting night). The competition will be held on January 20 and 
is closed to the members. Awards will be presented and winning images shown at the Annual Awards banquet 
held February 21. Here is what you need to know:

It's Time for Our 2017 Year-End Competition!

Maximum Images
Prints

Your 2017 Images

 The maximum number of images you may enter 
is 10 in each category. Categories are Creative, PJ, 
Monochrome, Nature, Open, Portraits and Scapes. 
Prints and Digital are separate divisions, so you 
may enter up to 10 in each category in prints as 
well as 10 in each category of digital. With the 
exception of Assigned, they must be entered in 
same category that they were originally during the 
competition year. Assigned images can be entered 
in another appropriate category, and will be part 
of the 10 chosen by you as your entries.

Prints must be received by me no later than
January 17 (The January regular meeting). They 
can also be dropped off at my home prior to that 
date. Since the deadline is only a few days before 
the competition, if you can get them to me sooner 
that would be great. You do not need to relabel 
your prints. They already should have a label on 
the back from the monthly competition. Please 
order them according to category, put your name 
on your bag or box if you want it returned, and 
please include a list of titles you are entering in 
each category.

I keep a spreadsheet of each member's entries for 
each competition year. If you would like a list of 
your entries, let me know and I can easily email 
your list to help you with your entries.

The Banquet and Awards will be held on Feb. 17. 
Please plan to attend. If you have not already paid 
your dues for the year, please include $5 per
member to cover the cost of pizza for the banquet. 
Guests are $10. Questions? Email me at:
photobug49@comcast.net or
competition1@grcameraclub.org

Classes

Digital

There are two classes - Class A and Star Class; 
you will compete with members in your skill 
level.  Members whose images received the 
highest average score in 2017 will compete in 
Star Class.

 DO NOT resend the images. Simply send a list 
of the images you wish to enter, and in the case 
of Assigned, the category they should be entered 
in. Send your list to images@grcameraclub.org.
The subject of your email should read GRCC 
Year-End Competition.

If you are bringing your prints on competition night
(Jan.17),  please email the list of titles to me prior to 
the meeting.

mailto:photobug49@comcast.net
mailto:competition1@grcameraclub.org
mailto:images@grcameraclub.org


Larry, can you give our GRCC members some background information on yourself?

The

6
Spring Continued on next page - See Heydenburg Interview

Way back when I was an
early teenager, my sister 
entered me in a grocery 
store drawing. My ticket 
was drawn and I won third 
place and received a Kodak 
Brownie Bullet Camera.  
A few weeks later my family 
took a trip to Washington DC, 
and I snapped away. I was 
“hooked” on photography.
To this day, some 46 years 
later in the Grand Rapids 
Camera Club, 
I’m still hooked.   

After returning from the 
service in 1965, I was in 
Mark's Photo and picked 
up a brochure for The 
Grand Rapids Color Slide 
Club (later the Calder 
City Camera Club). I soon 
joined and learned about 
the Grand Rapids Camera 
Club also. In 1971, I was 
ready for two clubs, so I 
joined the GRCC also.

I’ve always enjoyed competition and was taught by some of the 
best, including Evelyn Zeek, Joe Timmer and George Walker. 
These photographers would regularly share their knowledge and 
techniques with club members. I have always found great wealth 
of knowledge and workflow in competing in the monthly com-
petitions, workshops, teaching from the many speakers we have 
each month in the clubs. I have had no formal training in photog-
raphy but have learned all I know from club members, programs, 
and workshops and field trips that they had and continue to have 
at the clubs through the years.

iNTerView:  Larry heydeNburG by Greg Ferguson, GRCC Lights & Shadows Editor 

What made you decide to join GRCC and when?

Lighthouse Abstract

Narrow Focus Butterfly
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I enjoy all types of photography.  
With the ability now to take the 
image and process it all the way 
through to the end result, being 
as creative or using any style 
you want to express one’s self  
makes it all the more exciting 
for me. 
I especially enjoy going into the 
woods, finding small flowers or 
creatures, getting down next to 
nature itself and doing macro 
work. One of the best parts is 
after I have finished shooting 
the subject, I can roll over and 
watch the clouds roll by and 
listen to the many sounds of the 
nature all around me.
“Life is good!”

If I had any advice to give to 
club members it would be to ask 
questions and go on shooting
workshops with others.
See how they go about shooting. 
Maybe adapt some of their style 
to yours.
Learn from those around you 
and their workflow.
Another big benefit is the
camaraderie you have with
fellow photographers all
around you.   

What advice can you give others in the club to help them with their photography?

What kind of photography do you like to do?

HEYDENBURG INTERVIEW - Continued from previous page 

Celebration

Piercing Eyes

Neon Diagonals

Mystic Portrait
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The Image of the Month is chosen by one of our members as the image that appeals to them the most. 
Each month, the honor of choosing the image is assigned to a different GRCC member. This month’s 
favorite image from our December competition was chosen by Greg Ferguson.

WHY I LIKED IT:
Evie captured the moment with her Sunrise 
image. The color array got my attention and the 
leading lines of the trees (and the reflection in 
the open water) pulled my eye into the center at 
the edge of the pond. The ice in the foreground 
added depth to the image, and the darker
shadows on the left contrasted nicely with the 
snow and lighter imagery on the right.
Well done!
        - Greg

ABOUT MY IMAGE:
From a cityscape of bustling traffic and lights, come 
with me behind our house here in Grand Rapids and 
visit our “pondscape” in the quiet serenity of a
morning sunrise. You might hear the mallard
family protesting your visit, or see a fawn hiding in 
the thicket beyond the pond. This living running
water is a perfect choice for images showing off the
reflections of each season.  This was shot with my 
300mm lens and Canon 1dx.
        - Evie

december imaGe oF The moNTh Compiled by Jeanne Quillan

Chosen by Greg Ferguson“Sunrise”  by Evie Carrier 
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Timed exposure
Steve Port’s

A Bit of Photographic History

Steve Port
There is a lot on the internet (too much, maybe).  One prominent photography guru online is 
Moose Peterson.  In a recent Facebook article, he related a conversation with a photographer 
who espoused the goal of becoming a professional landscape photographer (his only planned 
income).  Not too remarkable except that he told Moose that he intended to use his iPhone 
only for image capture!  Moose found this intriguing and so do I. 

Are there other factors that are common to these two radically different platforms?  Two 
come to mind right off.  First is a “photographer’s eye".  Whether it’s a gift lodged in your 
DNA or a skill born of practice and determination, if you don’t own a photographic eye, 
things may not go well in this line of work.  The second is passion!  I have written before 
about the irreplaceable role of passion in art.  Passion may give rise to better art.  But for 
sure, no passion yields "meh".  Moose came to the same conclusion in his article.

So, if you are into photography and embrace the habit of New Year’s
resolutions, passion might be high on your list for 2018
(maybe #1, #2, and #3).  Happy New Year!

Many people’s preeminent historical hero of the art of landscape was, and maybe still is, 
Ansel Adams.  Images of ol’ Ansel standing next to his converted station wagon with a
shooting platform on its roof along with his 8x10 view camera still stir the soul of many.  
What possible factors would ever allow us to even remotely equate an iconic 8x10 view
camera with a tiny cell phone for the purpose of landscape photography? Turns out there are 
not very many.  Well sure, they both take pictures.  Technology, processing, and workflow 
really do not compare well without a real push of the imagination.  Skills are dramatically 
different as well as time commitment, intent, viewing medium, and a raft of other influences.  
It’s admittedly hard to imagine the next age’s “Ansel Adams” packing his gear in his jean 
pocket.  But, amazingly, every indicator seems to point in that direction.  Maybe not today, 
next week, or next year...but soon enough!



Dues are currently $35 for individuals 
and $50 for two individuals living at the 
same address. Also, if you plan to attend 
the February banquet, add $5 for each 
member. We also have PayPal available 
on our website for your convenience
(a small PayPal processing fee will be 
applied). Click on "Join" tab
to find the PayPal link.
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All GRCC members - If you have photographic-
related news that you would like to share with the 
club, let me know. It can be about you or another 
member. Email me at gcferguson@me.com 
and include the news in the email text or a Word or 
Pages attachment.

A big "Thank You" to Garnette Port
for all her help setting up the Finger 
Food table at our
December meeting!

We have a new member who joined our 
club recently.  Bonnie Mogle shoots with a 
Sony.  Please welcome Bonnie
when you see her.

If you have any changes to your email address or 
other information (such as address, phone number, 
camera) let Christine know at
treasurer@grcameraclub.org

2018 membership duesGoT News To share?

haVe chaNGes?

September ....Insects
October .........Sand Dunes
November .....Autumn
December .....Broken

January .... Effects of Age
March ...... After Dark
April ........ Fences
May .........Weeds, Reeds & Seeds SUMMER BREAK

 June .............Feathers

The 2018 Assigned Subjects are available on our website on the Competition Corner page.
A business-card-size list is also available at our meetings.

Grcc assiGNed subjecTs

a biG ThaNk you! New Grcc member

add To your smarT phoNe caLeNdar Now

Newsletters are planned for every month except July and August.  If you have
GRCC news, information or photos for the January Lights & Shadows, please
get these submitted on or BEFORE Friday, January 26, 2018.
You can send them to: LSNewsEditor@grcameraclub.org

by Greg Ferguson,
Lights & Shadows Editor

26
Jan.

L&S

mailto:gcferguson@me.com
mailto:treasurer@grcameraclub.org
mailto:LSNewsEditor%40grcameraclub.org?subject=
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creaTe a border or Frame iN phoToshop

Tips From keLLy... by GRCC Member Kelly Walkotten

Kelly lives in the greater
Grand Rapids area and her images 

have been exhibited in many venues 
around West Michigan including 
ArtPrize and Festival of the Arts.

Her work can be viewed at:
www.KellyWalkottenPhotography.com 

ABOUT KELLY WALKOTTEN

Make a Duplicate layer by dragging the 
photo onto the New Layer icon.

Make sure the Relative box is checked. 
Type the number of pixels to add around 
the edge. I chose 200. Each number is 
split between the edges so entering 200 
pixels in each field will give you a border 
width of 100 pixels. Make sure that the 
Anchor is set to the center square.

Enlarge the canvas.
Image > Canvas Size
Enlarge the canvas.
Image > Canvas Size

Click the down arrow on the canvas extension 
color, and chose Background and black.

Continued on next page -
See KELLY TIPS

Visual interest can be added to a photo by adding a frame.
This gives an appearance of an interior matte.
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Next, we are going to repeat 
these set of steps...

http://kellywalkottenphotography.com
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KELLY TIPS - Continued from previous page

Layer >
Flatten
Image

Chose Image > Canvas size again. You will now have a white matte with a 
black inside which will look like a matted 
print. You can chose other colors by
selecting Other in the Canvas Extension 
Color choice.

Again, make sure the
Relative box is checked.
Type the number of pixels to 
add around the edge. I chose 
1000. Each number is split 
between the edges so entering 
1000 pixels in each field will 
give you a border width of 500 
pixels. Make sure that the
Anchor is set to the center 
square. Click the down arrow 
on the canvas extension color, 
and chose Background and 
white this time.

© Kelly Walkotten 2015-18
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by Shealyn McGee Sarns, 
GRCC Digital Coordinator

by Christine Mooney, 
GRCC Treasurer

VisiTors are weLcome To aTTeNd our meeTiNGs!
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Regular meetings are held the third Wednesday of the 
month except for February, July and August. Meetings 
start promptly at 7:15 pm (so it's best to arrive by 7:00). 
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GuesTs are aLways weLcome aT our meeTiNGs. There is No GuesT Fee To aTTeNd This meeTiNG.

17
Jan.

Wed.

wedNesday, jaNuary 17, 2018
Grace Episcopal Church

1815 Hall St. SE
Grand Rapids, MI 49506

Jeanne Quillan covered the Year-End Competition details on page 5 in detail
(so be sure to read those if you haven't already).

If you are planning to enter digital images, you DO NOT need to resend the images to me... 
just send me a list of the images you wish to enter (that makes it easy for you and me).
Send the list to me via email with the subject "GRCC Year-End Competition" to
images@grcameraclub.org .

Remember, in case of images that were entered as Assigned, you will need to indicate what 
category they should be entered in for the year-end competition.

Thank you very much to those that have donated to our New Laptop Fund so far. 
Tim Priest (presentation fee), Mike Schlitt (presentation fee), Russ Barneveld (50/50 win-
nings), Ryan Charvat (auction purchase), Mike Mitchell (auction purchase) and Jan Lewis 
(check).  The total of these contributions is $589.50.
The estimated cost of the laptop and software is $1,500. So we are just about 40% there!

Also, thanks to Cathy and Jerry Keifer who donated equipment to our club for the auction. 

year-eNd compeTiTioN diGiTaL submissioNs

LapTop FuNd updaTe... we're GeTTiNG cLoser

mailto:images@grcameraclub.org

